
4 Series MSO
MSO44, MSO46
Installation and Safety

www.tek.com
071-3644-00

Supports 4 Series MSO Product Firmware V1.18.XX and above.

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its subsidiaries or suppliers, and are
protected by national copyright laws and international treaty provisions. Tektronix products are covered by U.S. and foreign patents, issued
and pending. Information in this publication supersedes that in all previously published material. Specifications and price change privileges
reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.
Contacting Tektronix
Tektronix, Inc.
14150 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA
For product information, sales, service, and technical support:

■ In North America, call 1-800-833-9200.
■ Worldwide, visit www.tek.com to find contacts in your area.

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          

http://www.tek.com


Warranty
Tektronix warrants that this product will be free from defects in materials and workmanship for a period of three (3) years from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective product
without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and replacement
products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced parts, modules and
products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period and
make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the defective
product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the product to
Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall be responsible
for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care.
Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel other than
Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or connection to
incompatible equipment; c) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product
that has been modified or integrated with other products when the effect of such modification or integration increases the time or difficulty
of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL
NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER
TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Important safety information
Safety information provides warnings and cautions that help you operate the instrument safely and keep the instrument in a safe
working condition.

This manual contains information and warnings that must be followed by the user for safe operation and to keep the product in a
safe condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary
Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or
any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

This product shall be used in accordance with local and national codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to
the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use. Do not use the
provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the
grounding conductor must be connected to earth ground. Before making connections to the input or output terminals of the
product, ensure that the product is properly grounded. Do not disable the power cord grounding connection.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location. Do not
position the equipment so that it is difficult to operate the power cord; it must remain accessible to the user at all times to allow for
quick disconnection if needed.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected to a voltage
source. Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be
suitable for the product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product
manual for further ratings information before making connections to the product. Do not exceed the Measurement Category
(CAT) rating and voltage or current rating of the lowest rated individual component of a product, probe, or accessory. Use caution
when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Do not float the common terminal above the rated voltage for that terminal.
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The measuring terminals on this product are not rated for connection to Category III or IV circuits.

Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open. Hazardous
voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the
product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use
probes or test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a warm
environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the installation instructions in the manual for details on installing the product so it has
proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into
any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may
result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Use care when lifting and carrying the product. This product is provided with a handle for lifting and carrying.

Use only the Tektronix rackmount hardware specified for this product.

Probes and test leads
Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.

Keep fingers behind the protective barrier, protective finger guard, or tactile indicator on the probes.

Remove all probes, test leads and accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and
adapters for any measurement.
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Beware of high voltages. Understand the voltage ratings for the probe you are using and do not exceed those ratings. Two
ratings are important to know and understand:

■ The maximum measurement voltage from the probe tip to the probe reference lead

■ The maximum floating voltage from the probe reference lead to earth ground

These two voltage ratings depend on the probe and your application. Refer to the Specifications section of the manual for more
information.

WARNING. To prevent electrical shock, do not exceed the maximum measurement or maximum floating voltage for the
oscilloscope input BNC connector, probe tip, or probe reference lead.

Connect and disconnect properly. Connect the probe output to the measurement product before connecting the probe to the
circuit under test. Connect the probe reference lead to the circuit under test before connecting the probe input. Disconnect the
probe input and the probe reference lead from the circuit under test before disconnecting the probe from the measurement
product.

Connect and disconnect properly. De-energize the circuit under test before connecting or disconnecting the current probe.

Connect the probe reference lead to earth ground only.

Do not connect a current probe to any wire that carries voltages or frequencies above the current probe voltage rating.

Inspect the probe and accessories. Before each use, inspect probe and accessories for damage (cuts, tears, or defects in the
probe body, accessories, or cable jacket). Do not use if damaged.

Service safety summary
The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of rendering
first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains power
before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect power, remove
battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.

 Important safety information
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Terms in the manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Terms on the product
These terms may appear on the product:

■ DANGER indicates an injury hazard immediately accessible as you read the marking.

■ WARNING indicates an injury hazard not immediately accessible as you read the marking.

■ CAUTION indicates a hazard to property including the product.

Symbols on the product

When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential
hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbols may appear on the product:
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Preface
This manual provides product safety and compliance information, describes how to connect and power on the oscilloscope, and
introduces the instrument features, controls and basic operations. See the product Help file for more detailed information.

Key features
Welcome to the 4 Series MSO. The 4 Series MSO Oscilloscopes (MSO44, MSO46) are 4- and 6-channel oscilloscopes with the
world's first FlexChannel® inputs, enabling you to efficiently and cost-effectively perform mixed signal debugging on virtually any
design.

■ Bandwidths from 200 MHz to 1.5 GHz

■ 4- and 6-channel models with FlexChannel® inputs

■ Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel
digital probe (the TLP058 FlexChannel Logic Probe)

■ Each FlexChannel can display 8 digital channels (with TLP058), an analog waveform, a spectrum trace, or both an analog
and spectral view of the same channel at the same time with independent controls for each view

■ Large 13.3” HD (1920 x 1080 pixel) capacitive touch-screen display

■ User interface optimized for touch screen use

■ Maximum 6.25 GS/s sample rate

■ 31.25 M points record length on all channels (optional 62.5 M record length available)

■ 500,000 waveforms/second capture rate

■ Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a
spectral trace for each channel

■ FastFrame™ segmented memory acquisition uses multiple trigger events to capture widely spaced events of interest at high
sample rates while conserving acquisition memory

■ No set limit on the number of math, reference, and bus waveforms you can display (the number of waveforms depends on
available system memory)

■ Integrated options include a 50 MHz arbitrary/function generator (AFG), and a Digital Voltmeter (DVM) and trigger frequency
counter

■ Advanced serial bus triggering and analysis options let you decode and trigger on industry standard buses. See the Serial
bus and trigger options Help topic

■ Measurement and analysis options provide additional measurement and analysis functions. See the Advanced Power
Analysis option Help topics
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Related documents
Use the related documents for more information on instrument functions, how to remotely program or operate the instrument,
understand theory of operation, replace suspected modules, and do other tasks.

MSO44, MSO46 documents

To learn about Use this document
How to use instrument
functions

4 Series MSO (MSO44, MSO46) Installation and Safety Manual (This document, Tektronix part
number 071-3644-xx); standard accessory with the instrument. Single document with English,
Japanese, and Simplified Chinese languages. A Russian language version is available to
download from the Tektronix web site (Tektronix part number 077-1511-xx)
 
4/5/6 Series MSO Help (Tektronix part number 077-1303-xx; Printable version of the instrument
Help that contains context-sensitive descriptions of all instrument functions; available at
www.tek.com/downloads)

How to remotely control the
instrument

4/5/6 Series MSO Programmer Manual (Tektronix part number 077-1305-xx; available at
www.tek.com/downloads)

Instrument specifications and
procedures to verify the
instrument meets
specifications

4 Series MSO MSO44, MSO46 Specifications and Performance Verification Technical
Reference (Tektronix part number 077-1546-xx; available at www.tek.com/downloads)

Instrument theory of operation,
troubleshooting, disassembly,
and replaceable parts

4 Series MSO MSO44, MSO46 Service Manual (Tektronix part number 077-1547-xx; available
at www.tek.com/downloads)

Installing the instrument in a
rack

RM4 Rack Mount Kit Instructions (Tektronix part number 071-3645-xx; available at
www.tek.com/downloads)

Using the TLP058 Logic Probe TLP058 FlexChannel® Logic Probe Instructions (Tektronix part number 071-3515-xx; available
at www.tek.com/downloads)

Preface  

viii MSO44, MSO46 Installation and Safety Manual

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Installing your instrument

Check shipped accessories
Make sure that you received everything you ordered. If anything is missing, contact Tektronix Customer Support. In North
America, call 1-800-833-9200. Worldwide, visit www.tek.com to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all standard accessories and ordered
items. If you purchased factory installed options such as a Serial Bus and Triggering option, or the Power measurements option,
tap Help > About to confirm that the option(s) are listed in the Installed Options table.

MSO44, MSO46 standard accessories

Item Quantity Tektronix part number
4 Series MSO (MSO44, MSO46) Installation and Safety Manual 1 071-3644-xx
TPP0250 Passive Voltage Probe (250 MHz bandwidth). Shipped with
200 MHz models

4   1 TPP0250

TPP0500B Passive Voltage Probe (500 MHz bandwidth). Shipped with
350 MHz, 500 MHz, 1 GHz and 1.5 GHz models

4  1 TPP0500B

Accessory pouch 1 016-2143-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A
Report of factory installed licenses 1 N/A

Safely rotate the handle
Use the correct process to eliminate the chance of pinching your thumb or rear-panel-connected cables while rotating the handle.

CAUTION. Hold the top of the handle to rotate the handle on the instrument. Do not hold the handle from the sides and rotate, as
this can pinch the base of your thumb between the handle and the case.

If you have routed any cables between the handle and the case, be careful when rotating the handle so that you do not pinch the
cables.

 

1 Four probes are shipped with 4- and 6-channel models.
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Operating requirements
Use the oscilloscope within the required operating temperature, power, altitude, and signal input voltage ranges to provide the
most accurate measurements and safe instrument operation.

Environment requirements

Characteristic Description
Operating temperature 0 °C to +50 °C (+32 °F to +122 °F)

 
For proper cooling, keep the sides of the instrument clear of obstructions for 2 inches
(51 mm).

Operating humidity 5% to 90% relative humidity (% RH) up to +40 °C (+104 °F), Noncondensing.
 
5% to 50% RH above +40 °C up to +50 °C (+104 °F to +122 °F), Noncondensing.

Operating altitude Up to 3000 meters (9842 feet)

Power requirements

Characteristic Description
Power source voltage 100 V - 240 VAC RMS, ±10%, single phase
Power source frequency 50/60 Hz, 100-240 V

 
400 Hz, 115 V

Power consumption All models: 400 W maximum

Installing your instrument  
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Input signal requirements
Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and
digital probes or instrument.

Make sure that input signals are within the following requirements.

Input Description
Analog input channels, 1 M Ω setting, maximum
input voltage at BNC

300 VRMS
 

Analog input channels, 50 Ω setting, maximum
input voltage at BNC

5 VRMS

Digital input channels, maximum input voltage
range at digital inputs

Observe probe ratings
 
TLP058; ±42 VP

Ref In maximum input voltage at BNC (rear panel) 7 VPP

Aux In trigger input ≤300 VRMS

Secure (lock) the oscilloscope
Lock an oscilloscope to a test bench or equipment rack to prevent property loss.

Attach a standard laptop security lock to the rear panel of the oscilloscope, to secure the oscilloscope to a workbench, rack, or
other location.
 

 

 Installing your instrument
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Powering the oscilloscope
Use this procedure to connect the oscilloscope to line power and power on and off the oscilloscope. Always connect the
oscilloscope to AC power using the power cord that shipped with the instrument.

Prerequisite: Use the AC power cord that shipped with your oscilloscope.

1. Connect the supplied power cord to the oscilloscope power connector on the back of the instrument.

Figure 1: MSO44, MSO46 power cord connector and power standby switch

 

2. Connect the power cord to an appropriate AC mains source.
Power is supplied to the power supply and some other boards whenever the AC power cord is connected to a live mains
circuit, putting the instrument in standby mode.

3. Push the front panel power button to power the instrument on and off.
The power button color indicates instrument power states:

Unlit – no AC power applied

Yellow – standby mode

Blue – powered on

4. To completely remove power from the instrument, disconnect the power cord.

Installing your instrument  
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Check that oscilloscope passes power-on self tests
Power-on self tests verify that all oscilloscope modules are working correctly after power up.

1. Power on the oscilloscope and wait until the oscilloscope screen appears.

2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.

3. Check that the status of all power-on self tests are Passed.

If one or more power-on self tests shows Failed:

a. Power cycle the oscilloscope.

b. Tap Utility > Self Test. If one or more power-on self tests still shows Failed, contact Tektronix Customer Support.

Connecting Probes
Probes and cables connect the oscilloscope to your device under test (DUT). Use a probe that best matches your signal
measurement needs.

 
Figure 2: Connecting probes to the MSO44 or MSO46

Connect TPP Series, TekVPI+, TekVPI, or other supported Tektronix analog probes by pushing them into a FlexChannel
connector. The probe base latch locks with a 'click' when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If
a probe has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active
probes to set their parameters (auto zero, degauss, and so on).

To connect a TLP058 FlexChannel Logic Probe or a TDP7700 Series TriMode™ Probe:

1. Move the locking lever to the unlocked position, then let go to reset locking lever to the center position.

2. Insert the probe into a FlexChannel connector until fully seated and the lock mechanism clicks.

 Installing your instrument
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3. Move the locking lever to the locked position. The status light should be a solid green.

4. To disconnect the TLP058 probe, move and hold the locking lever at the unlocked position and pull out the probe. Do not
pull on the ribbon cable while removing the probe.

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until
it locks.

NOTE. Connecting a probe does not automatically enable that channel (make it active). Use the instrument controls or
programmatic interface to turn on a channel and open its configuration menu to verify or change probe or cable settings
(bandwidth, attenuation, termination and so on).

Rackmount option information
An optional rackmount kit lets you install the oscilloscope in standard equipment racks. The rackmount kit requires seven rack
units (7U) of space to install.

Contact Tektronix Customer Support to purchase the RM4 rackmount kit option. Follow the instructions that come with the
rackmount kit (RM4 Rackmount Kit Instructions, Tektronix part number 071-3645-xx).

Make sure to allow at least two inches of clearance on the sides for air ventilation, and on the back for any cables you attach to
the rear panel.

Installing your instrument  
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Getting acquainted with your instrument
The following content provides a high-level description of the instrument controls and user interface.

Refer to the instrument help for detailed information on using the controls and user interface to display waveforms and take
measurements.

Front panel controls and connectors
The front panel controls provide direct access to key instrument settings such as vertical, horizontal, trigger, cursors, and zoom.
The connectors are where you input signals with probes or cables, or insert USB devices.

Figure 3: 4 Series MSO Controls

 

1. Acquisition and Cursors controls:
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■ Run/Stop starts and stops waveform acquisition. The button color indicates the acquisition status (green = running and
acquiring; red = stopped). When stopped, the oscilloscope shows waveforms from the last completed acquisition. The
Run/Stop button on the screen also shows the acquisition status.

■ Cursors button turns screen cursors on or off. Use the Multipurpose knobs to move the cursors. Double-tap the cursor
readouts, or on a cursor bar (line), to open the configuration menu to set cursor types and functionality. See Display
and configure cursors on page 49.

■ Fast Acq™ enables or disables the fast acquisition mode. FastAcq provides high-speed waveform capture that
reduces the dead time between waveform acquisitions, enabling the capture and display of transient events such as
glitches and runt pulses. It is helpful in finding elusive signal anomalies. Fast acquisition mode can also display
waveform phenomena at an intensity that reflects their rate of occurrence.

■ Single/Seq enables making a single waveform acquisition, or a specified number of acquisitions (as set in the
Acquisition configuration menu). Pushing Single/Seq turns off Run/Stop mode and takes a single acquisition. The
button color indicates the acquisition status (quick green flash = single acquisition acquired; solid green = waiting for
trigger event). Pushing Single/Seq again takes another single acquisition.

■ High Res applies unique finite impulse response (FIR) filters based on the current sample rate. This FIR filter
maintains the maximum bandwidth possible for that sample rate while rejecting aliasing. The filter removes noise from
the oscilloscope amplifiers and ADC above the usable bandwidth for the selected sample rate. Implementation of the
filter in hardware, ahead of the trigger and storage, reduces trigger jitter and enables using Fast Acq mode while in
High Res mode.

High Res mode also guarantees at least 12 bits of vertical resolution. The number of bits of resolution is displayed in
the Acquisition badge at the bottom of the screen. The Horizontal badge also updates to show the sample rate and
record length settings while in High Res mode.

■ Clear deletes the current acquisitions and measurement values from memory.

2. Multipurpose knobs:
 

 

■ Multipurpose knobs (A, B) The Multipurpose knobs A and B move cursors and set parameter values in configuration
menu input fields. Selecting an menu field that can use a Multipurpose knob assigns the indicated knob to change the
value in that input field. The ring around each knob lights when you can use that knob to do an action.
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Push a Multipurpose knob to enable the Fine mode for making smaller increment changes. Push the knob again to exit
Fine mode.

3. Trigger controls:
 

 

■ Force forces a trigger event at a random point in the waveform and captures the acquisition.
■ Level sets the amplitude level that the signal must pass through to be considered a valid transition. The color of the

Level knob indicates the trigger source except for dual-level triggers. The Level knob is disabled when the trigger type
requires two level settings or other trigger qualifiers (set from the Trigger configuration menu). Push the knob to set the
threshold level to 50% of the peak-to-peak amplitude range of the signal.

■ Slope sets the signal transition direction to detect for a trigger (low to high, high to low, or either direction). Push the
button to cycle through the selections. The Slope button is disabled when the trigger type requires other slope
qualifiers (set from the Trigger configuration menu).

■ Mode sets how the instrument behaves in the absence or presence of a trigger event:

■ Auto trigger mode enables the instrument to acquire and display a waveform whether or not a trigger event
occurs. If a trigger event occurs, the instrument displays a stable waveform. If a trigger event does not occur, the
instrument forces a trigger event and acquisition and displays an unstable waveform.

■ Normal trigger mode sets the instrument to acquire and display a waveform only when there is a valid trigger
event. If no trigger occurs, the last waveform record acquired remains on the display. If no last waveform exists,
no waveform is displayed.
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4. Vertical controls:
 

 

■ Position moves the selected waveform (Channel, Math, Reference, Bus) and its graticule up or down on the screen.
The color of the Position knob indicates which waveform the knob is controlling. Push the knob to set the threshold
level to 50% of the peak-to-peak amplitude range of the signal.

■ Scale sets the amplitude units per vertical graticule division of the selected waveform. The scale values are shown on
the right edge of the horizontal graticule lines, and are specific to the selected waveform in both Stacked or Overlay
modes (in other words, each waveform has its own unique vertical graticule settings regardless of display mode). The
color of the Scale knob indicates which waveform the knob is controlling.

■ Channel buttons turn on (display), select, or turn off Channel, Math, Reference, or Bus waveforms. The number of
channel buttons depends on the instrument model. The buttons operate as follows:

■ If the channel is not displayed, pushing a Channel button turns on that channel to the Waveform view.
■ If the channel is on the screen and is not selected, pushing that channel's button selects that channel.
■ If the channel is on the screen and is also selected, pushing that channel's button turns that channel off (removes

it from Waveform view).
■ The Math button adds or selects a Math waveform on the Waveform view, as follows:

■ If no Math waveform exists, pushing the Math button adds a Math waveform to the Waveform view and opens the
Math configuration menu.

■ If only one Math waveform is displayed, pushing the button turns off the Math waveform (removes it from
Waveform view). Push the button again to display the waveform.

■ If two or more Math waveforms are displayed, pushing the button cycles through selecting each math waveform.
■ The Ref button adds or selects a Reference (saved) waveform on the Waveform view, as follows:

■ If no Reference waveform exists, pushing the Ref button opens the Browse Waveform Files configuration menu.
Navigate to and select a waveform file (*.wfm) and tap Recall to load and display the reference waveform.

■ If only one Reference waveform is displayed, pushing the button turns off the Reference waveform (removes it
from the Waveform View). Push the button again to display the waveform.

■ If two or more Reference waveforms are displayed, pushing the button cycles through selecting each Reference
waveform.

■ The Bus button adds or selects a bus waveform on the Waveform view, as follows:

■ If no Bus waveform exists, pushing the Bus button adds a Bus waveform to the Waveform view and opens the
Bus configuration menu.

■ If only one Bus waveform is displayed, pushing the button turns off the Bus waveform (removes it from Waveform
view).

■ If two or more Bus waveforms are displayed, pushing the button cycles through selecting each Bus waveform.
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5. Horizontal controls:
 

 

■ Position moves the waveform and graticule side to side on the screen (changing the trigger point position in the
waveform record). Push the knob to center the trigger event to the center graticule on the Waveform view.

■ Scale sets the time per major horizontal graticule division and samples/second parameters for the oscilloscope. Scale
applies to all waveforms. Push the knob to enable the Fine mode for making smaller increment changes. Push the
knob again to exit Fine mode.

■ Zoom opens the Zoom mode. Push Zoom again to exit zoom mode. See The Zoom user interface elements on
page 27.

■ Zoom knob (center knob) increases or decreases the area of the zoom box in the Zoom Waveform Overview, which in
turn controls the zoom amount of the waveforms shown in the main Zoom view.

■ Pan knob (outer knob) moves the Zoom box left or right in the Zoom Waveform Overview, which in turn controls the
part of the waveform shown in the main Zoom view.

■ Navigate (left and right arrow) buttons puts the oscilloscope in Zoom mode and positions the previous or next search
point in the waveform record to the center graticule of the Waveform view. There must be a Search badge present in
the Results bar before the Navigate function will operate. Press and hold a front panel navigate button to continue
moving to the next search point in that direction. See Badges on page 20.

The front panel Navigate buttons can also be used for the Previous and Next button functions on measurement
badges.
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6. Miscellaneous controls:
 

 

■ Touch Off turns touch screen capability off. The Touch Off button is lighted when the touch screen is turned off.
■ Save is a one-push save operation that uses the current File > Save As settings to save screen shots (including open

menus and dialog boxes), waveform files, instrument settings, and so on, as follows:

■ If a File > Save or File > Save As operation has occurred since the last instrument startup, pushing Save saves
the file types to the location last set in the Save As configuration menu.

■ If no file save operation has occurred since the last instrument startup, pushing Save opens the Save As
configuration menu. Select a tab to select the type of file to save (Screen Capture, Waveform, and so on), set any
associated parameters, and where to save it, and select OK. The specified file or files are saved. The next time
you push Save, the same type files are saved.

■ Screen Captures capture the entire screen, including most displayed configuration menus and dialog boxes.
■ Default Setup restores the oscilloscope settings (horizontal, vertical, scale, position, and so on) to the factory default

settings.
■ Autoset automatically displays a stable waveform. See Quickly display a waveform (Autoset) on page 37.

7. Ground and Probe Compensation connectors:
 

 

■ The Ground and Probe Compensation connectors are located at the lower right side of the instrument, near the front
panel. The Ground connector (the small hole in the case) provides an electrically grounded (through a resistor)
connection point to attach an anti-static wrist strap, to reduce electrostatic damage (ESD) while you handle or probe
the DUT.

■ The Probe Compensation connections provide a ground connector (upper tab) and 1 kHz square wave source (lower
tab) for adjusting the high-frequency response of a passive probe (probe compensation). The oscilloscope uses this
signal to automatically compensate supported probes, including the ones that ship with the product. See Compensate
the TPP Series probes on page 32.

8. USB Host ports (USB 2.0):

■ USB ports are located at the lower right corner of the front panel, and on the rear panel. Connect USB flash drives to
which you can save or recall data (such as instrument software updates, waveforms, settings, and screen captures), or
connect peripheral devices such as a mouse or keyboard.
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9. FlexChannel probe connectors:

Figure 4: 4 Series MSO

■ FlexChannel connectors support all TekVPI+ and TekVPI measurement probes, BNC passive probes, the TPL058
FlexChannel Logic Probe, and BNC cables. You connect most probes simply by pushing them into the connector until
the probe seats with a click. See Connecting Probes on page 5.

10. Aux In auxiliary trigger input connector (4 Series, 6 Series only):

A connector to which you can connect an external trigger input signal. Use the Aux In trigger signal with the Edge trigger
mode.

 Getting acquainted with your instrument

MSO44, MSO46 Installation and Safety Manual 13

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Rear panel connections
The rear panel connections supply power to the oscilloscope and provide connectors for network, USB devices, video, reference
signals, and the AFG output.

Figure 5: 4 Series MSO

4 Series MSO
1. LAN connector (RJ-45) connects the oscilloscope to a 10/100/1000 Base-T local area network.

2. USB 2.0 Device port lets you connect to a PC to remotely control the oscilloscope using USBTMC protocol.

3. USB 2.0 Host ports let you connect a USB memory device, keyboard, or mouse.

4. HDMI video output lets you connect an external monitor or projector to show the oscilloscope screen.

NOTE. You must connect an external monitor before powering on the instrument.

5. AUX Out generates a signal transition on a trigger event, outputs a 10 MHz reference signal, or outputs a synchronization
signal from the AFG.

6. Ref In lets you connect a high-precision 10 MHz reference signal to the oscilloscope for more accurate measurements.

7. AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.

8. Security lock connector lets you use a standard PC/laptop lock cable to secure the oscilloscope to a work bench or other
location.

9. Power cord connector. Use only the power cord specified for this product and certified for the country of use.

Getting acquainted with your instrument  

14 MSO44, MSO46 Installation and Safety Manual

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



The user interface screen
The touch screen user interface contains waveforms and plots, measurement readouts, and touch-based controls to access all
oscilloscope functions.

1. The Menu bar provides menus for typical operations including:

■ Saving, loading, and accessing files
■ Undoing or redoing an action
■ Setting oscilloscope display and measurement preferences
■ Configuring network access
■ Running self tests
■ Erasing measurement and settings memory (TekSecure™)
■ Loading option licenses
■ Opening a Help viewer.

2. The Waveform View area displays analog, digital, math, reference, bus, and trend waveforms. The waveforms include
waveform handles (identifiers), individual vertical graticule scale labels, and trigger position and level(s) indicators. You can
set the Waveform View to stack each waveform vertically in separate graticules, called 'slices' (the default mode, as shown
in the previous image), or overlay all the waveforms on the screen (traditional waveform view). See The user interface
elements on page 16.

You can also add Histogram, Spectral, and Measurement Results views (plots) for individual measurements. These plot
views are separate view windows that you can move on the screen by dragging their title bar to a new position.
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3. The Results Bar contains controls for displaying cursors, adding notes, plots, and result tables to the screen, and add
measurements to the Results bar. The controls are:

■ The Cursors button displays on-screen cursors in the selected view. Touch and drag, or use the Multipurpose knobs,
to move the cursors. Double-tap on a cursor, or on the cursor readouts, to open a configuration menu to set cursor
types and related functions.

■ The Measure button opens a configuration menu from which to select and add measurements to the Results bar. Each
measurement you add has a separate badge. Double-tap a measurement badge to open its configuration menu.

■ The Results Table button adds a Measurement or Bus Results table to the screen. The Measurement Results table
displays all measurements present in the Results bar. The Bus Results table displays bus decode information for
displayed bus waveforms. Each table is contained within its own view window, which can be moved within the display
area.

■ The Note button adds a note object to the selected view. Double-tap the note text to open a configuration menu to
change the text and font characteristics. Drag the note to any location on the view. Notes cannot be added to a
Results Table view.

■ The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a Search
configuration menu and set the search conditions for analog and digital channels. You can add any number of
searches to the same waveform or to different waveforms. Search badges are added to the Results Bar.

■ The Plot button adds an XY, XYZ, or Eye Diagram plot to the display. These plots are contained within their own
window and can be moved within the overall display area.

■ The Measurement and Search badges show measurement and search results, and are displayed in the Results Bar.
See Badges on page 20. See Add a measurement on page 42. See Add a Search on page 47.

■ The Draw-a-Box button at the bottom of the Results Bar lets you toggle between drawing a box on the screen to
zoom in on an area of interest, or drawing areas to define visual trigger conditions.

■ The Trash Can icon lets you drag Channel, Waveform, Measurement, and Search badges to the Trash Can to delete
them.

4. The Settings Bar contains System badges for setting Horizontal, Trigger, Acquisition, and Date/Time parameters; Inactive
Channel buttons to turn on channels; Add New Waveform buttons to add math, reference, and bus waveforms to the
display; and Channel and Waveform badges that let you configure the individual waveform parameters. Tap a channel or
waveform button to add it to the screen and display a badge. Double-tap a badge to open its configuration menu. See 
Badges on page 20.

5. Configuration Menus let you quickly change the parameters of the selected user interface item. You can open
configuration menus by double-tapping on badges, screen objects, or screen areas. See Configuration menus on page 26.

The user interface elements
Each area of the user interface has a specific function that helps manage information or controls. This topic shows and describes
the key user interface elements.
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1. The Waveform Record View is a graphical high-level view of the overall waveform record length, how much of the record is
on the screen (shown in brackets), the location of key time events including the trigger event, and the current position of
waveforms cursors.
 

 

If you are displaying a Reference waveform that is shorter than the current acquisition record length, or you are changing
the horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to show the part of the
waveform record that is being viewed relative to the current acquisition total record length.
 

 

If cursors are active on a waveform, the Waveform Record View shows the relative cursor positions as small vertical dashed
lines.
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When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview. See The Zoom user interface
elements on page 27.

2. The Expansion Point icon on the waveform view shows the center point around which the waveform expands and
compresses when changing horizontal settings.
 

 
3. The Trigger Position Indicator shows where the trigger event occurred in the waveform record. The trigger icon is displayed

in the waveform slice that is the trigger source.
 

 
4. The Zoom icon (in upper right corner of Waveform and Plot views) toggles zoom on and off. The front panel Zoom button

and knobs also turn on zoom mode and change the position and horizontal size of the Zoom Box.
 

 
5. The Trigger Level Indicator icon(s) shows the trigger level on the trigger source waveform. Some trigger types require two

trigger levels.
6. Measurement and Search badges show measurement and search results. See Badges on page 20. See Add a

measurement on page 42.
7. The Results Bar Handle opens or closes the Results bar, to maximize waveform screen viewing when needed. To reopen

the Results bar, either tap the handle icon or swipe left from the right side of the display.
8. The System badges show global instrument settings (Horizontal, Trigger, Acquisition, Run/Stop status, and Date/Time).

See Badges on page 20.
9. The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the

Settings bar.

The Add New Math, Add New Ref, and Add New Bus buttons add the corresponding signal to the Waveform view, and
add an associated Waveform badge to the Settings bar. You can add any number of Math, Reference, and Bus waveforms,
limited only by system memory.

The optional AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if
the AFG option is installed.

The optional DVM button lets you use an analog probe to take DC, AC RMS, or DC+AC RMS voltage measurements on
your DUT. Tap the button to add a DVM badge to the Results Bar and open a configuration menu. The DVM option also
enables a trigger frequency counter, accessible from the Mode & Holdoff panel in the Trigger badge menu. This button is
only present if the DVM option is installed.

10. Double-tap a badge to open its associated configuration menu. See Badges on page 20. See Configuration menus on
page 26.

If you add more Channel or Waveform badges than can fit in the waveform badge display area, tap the scroll buttons at
each end of the waveform badge area to scroll and display hidden badges.
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11. The Waveform Handles on each waveform identify the source of that waveform (Cx for channels, Mx for Math waveforms,
Rx for Reference waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform by
default. The currently selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number, each individual digital signal labeled D0–D7 and
displayed with a different color.
 

 

Double-tapping a digital waveform handle opens the digital channel configuration menu.
Dragging a digital signal handle over another handle swaps those two signals on the waveform.

12. The probe Dynamic Range Limit Markers are displayed just within the left-hand graticule edge, based at the channel vertical
trace handle position and extending up and down to the dynamic range limits of the probe. The markers are only displayed if
compatible probes are used. Signals must be within the probe dynamic range for the oscilloscope to correctly display and
measure the signals.

The markers are displayed, for about three seconds, after any Offset, Position, or Scale control change that leaves the
channel dynamic range limits within the acquisition window. After about three seconds the markers become short lines at
the left edge of the graticule. If the dynamic range is too small to display the arrows, the arrows are omitted. Examples of all
three marker versions are shown.
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Badges
Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast
access to configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges
Channel and Waveform (Math, Ref, Bus, Trend) badges are shown in the Settings Bar, located along the bottom left of the
screen. Each waveform has its own badge. The badges show high-level settings for each displayed channel or waveform.
Double-tap a badge to open its configuration menu.
 

 

Most Channel and Waveform badges also have Scale buttons, shown by single-tapping the badge. Use the Scale buttons to
increase or decrease the vertical scale setting for that waveform.
 

 

You can drag Channel and Waveform badges to change their position in the Settings bar, or drag them into the Trash Can icon
to turn them off.

Channel badges are listed in the channel order unless you have moved them. Channel badges may also display short error or
warning messages. For more information double-tap the badge to open its configuration menu, or search the instrument Help.

Waveform badges (Math, Ref, Bus, Trend) are listed in the order created (unless they have been moved), and are grouped
together by type. Deleting a Waveform badge does not change the order or names of the remaining badges.

Measurement badges
Measurement badges are located in the Results Bar. They show measurements or search results. The badge title also shows
the measurement source or sources. To add a Measurement badge, tap the Add New Measurement button and select a
measurement.
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Double-tap a Measurement badge to open its configuration menu to change or refine settings. The default measurement badge
readout shows the measurement's mean (μ) value.

Some measurements and their badges are only available as options. For example, Power measurements are only listed in the
Add New Measurement menu if the 4-PWR option is installed.

To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu
and select Show Statistics in Badge.
 

 

Some Measurement badges also have Navigation buttons, shown by single-tapping the badge.
 

 

The < (Previous) and > (Next) buttons center the waveform in the display at the position of the previous or next measurement
point in the record (for measurements that take more than one measurement per acquisition).

The Min' and Max' navigation buttons center the waveform in the display at the minimum or maximum value for that
measurement in the current acquisition.

The prime symbol (') shown on measurement readings and Min/Max buttons indicates that the value shown (or moved to in the
case of Min/Max buttons and waveforms) is from the current acquisition. Lack of a prime symbol means the value is from all
acquisitions.

Measurement badges are listed in the order created, starting at the top of the Results bar. Deleting a Measurement badge does
not change the order or names of the remaining badges.

You can drag Measurement badges to change their position in the Results bar, or drag them into the Trash Can icon to delete
them.
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Search badges
Search badges are also shown in the Results Bar, below the Measurement badges. A search badge lists the search source,
search type, and the number of search event occurrences in the current acquisition. The instrument marks the waveform where
those events occur with small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to
open its configuration menu to change or refine search settings.
 

 

Search badges are created by tapping the Add New... Search button. Use the displayed configuration menu to set the search
criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the
display at the position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only
usable when the oscilloscope is in single acquisition mode. Single-tap a badge to close the Navigation buttons.

Some searches also provide Min and Max navigation buttons that open the Zoom mode and center the waveform in the display
at the minimum or maximum value for that search event in the current acquisition.

Search badges are listed in the order created. Deleting a Search badge does not change the order or names of the remaining
badges.

You can drag Search badges to change their position in the Results bar, or drag them into the Trash Can icon to delete them.
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Signal Clipping and Badges

WARNING. Clipping is caused by excessive or dangerous voltage at the probe tip, and/or a vertical scale setting that is not
adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and
cause damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the words Clipping in a Channel badge when a vertical clipping condition
exists. Any measurement badges associated with that channel also indicate a clipping condition by turning the measurement text
red and listing the type of clipping (positive or negative).
 

 

To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the
excessive voltage source, and check that you are probing the correct signal using the correct probe.

Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved
waveform files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.

Error Messages and Badges
This instrument shows a warning triangle symbol and an error message abbreviation in a Channel badge when an error occurs.
 

 

To remove the message from the badge, clear the error as indicated in the table.

Table 1: Probe errors

Error message Description
Prb Comm Accessory communication timed out. Please re-attach the accessory.
Prb ROM Unable to read probe ROM. Please re-attach the accessory.
Unsup Accessory is unsupported.
Prb Fault Critical accessory fault. Please re-attach the accessory. If the problem persists, contact Tektronix service.
Over Rng The signal voltage or current is over range. Please reduce the signal amplitude.
Temp The probe has experienced an over temperature condition. Please remove the probe from the high

temperature area.
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Error message Description
No Tip No probe tip detected. Please install a compatible probe tip.
Tip Fault The probe tip has a fault. Please remove and replace the probe tip.

System badges
System badges (in the Settings bar) display the main Horizontal, Trigger, and Acquisition settings. You cannot delete System
badges.
 

 

Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase
or decrease the horizontal time setting.
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Common badge actions

Action Result Example
Single tap Immediate access controls (Scale,

Navigation).

Double tap Configuration menu with access to
all settings for the badge.

 

 

Badge selection status
The appearance of a badge indicates its selection status (selected or unselected), or if a measurement needs to be deleted to
close a channel or waveform badge.
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Badge type Selected Unselected Turned off or in use  1

Channel or
Waveform

Measurement N/A

Configuration menus
Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger, Acquisition),
measurements, cursor readouts, Waveform and Plot views, note text, and so on.

Double-tap an item (badge, Waveform View or Plot View, cursor readouts, note text, and so on) to open its configuration menu.
For example, double-tap a Channel badge in the Settings Bar to open its configuration menu.

Selections or values that you enter take effect immediately. Menu contents are dynamic, and can change depending on your
selections, instrument options, or attached probes.

Related settings are grouped into 'panels.' Tap the panel name to show those settings. Changes to panel settings can change
the values and/or fields shown in that panel and other panels.
 

1 A dimmed Channel badge means the screen waveform is turned off (but not deleted). A dimmed Waveform badge means that the waveform display is turned off, or it is
being used as a source by a measurement and cannot be deleted until the measurement is deleted.
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Tap anywhere outside a configuration menu to close it.

To open Help content for a configuration menu, tap the question mark icon in the upper right corner of the menu.

The Zoom user interface elements
Use the zoom tools to magnify waveforms to view signal details.

1. The Zoom Overview shows the entire waveform record. All waveforms are shown in Overlay mode in the Zoom Overview
area.

NOTE. Using pinch and expand gestures on the Zoom Overview waveforms changes the horizontal time base settings.

2. The Zoom Box shows the area of the Zoom Overview to display in the Zoom View (see 5). You can touch and drag the box
to move the area to view. You can also use the zoom Pan knob to move the Zoom Box left or right.

NOTE. Moving the Zoom Box, or changing its position, does not change the horizontal time base settings.

3. The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.

4. The Draw-a-Box button toggles between drawing a zoom box (default mode) and drawing areas for the Visual Trigger
function. The button is located at the bottom of the Results Bar.

A zoom box lets you quickly draw a box around an area of interest in the Waveform or Zoom Overview. Drawing a box
immediately puts the oscilloscope into zoom mode. To draw a zoom box, tap the Draw-a-Box button (while in Zoom mode),
then touch and drag on the waveform to draw a box waveform. You can continue to draw zoom boxes until you single tap
anywhere on the screen or open a menu.

To toggle between zoom mode and Visual Trigger mode, double-tap the Draw-a-Box button and select Visual Trigger.
Search for the Visual Trigger topics in the oscilloscope embedded Help for more information on Visual Trigger.
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5. The Zoom View shows the zoomed waveforms, as marked by the Zoom Box, in the Zoom Waveform Record View. Use
pinch and/or drag options in the zoom view to change the zoomed area of interest.

NOTE. Pinch, expand, and drag gestures in the Zoom View only change zoom magnification settings and Zoom Box
position.

6. Use the Zoom Title Bar controls to adjust the vertical and horizontal size of the zoom area. Click or tap the + or - buttons.
 

 

Using the touch screen interface for common tasks
Use standard touch screen actions, similar to those found on smart phones and tablets, to interact with most screen objects. You
can also use a mouse to interact with the UI. The equivalent mouse operation is shown for each touch operation.

The oscilloscope has a user interface tutorial. Tap Help > User Interface Tutorial to quickly learn the fundamental touch
operations.

 

Table 2: Common touchscreen UI tasks (with mouse equivalents)

Task Touchscreen UI action Mouse action
Add a channel, math, reference, or bus
waveform to the screen.

Tap an inactive channel button, Add New
Math, Add New Reference, or Add New
Bus button.

Click an inactive channel button, Add
New Math, Add New Reference, or Add
New Bus button.

Select a channel, math, reference, or bus
waveform to make it active

Stacked or Overlay mode: Tap the
Channel or Waveform badge.
Stacked mode: Tap the channel, math,
reference, or bus waveform slice or
handle.
Overlay mode: Tap the channel or
waveform handle.

Stacked or Overlay mode: Left-click the
Channel or Waveform badge.
Stacked mode: Left-click the channel,
math, reference, or bus waveform slice or
handle.
Overlay mode: Left-click the channel or
waveform handle.

Display scale or navigation buttons on a
badge (waveform, measurement  1,
search, horizontal).

Tap the badge. Click the badge.

Open a configuration menu on any item
(all badges, views, cursor readouts,
labels, and so on).

Double-tap the badge, view, or other
object.

Double-click the badge, view, or other
object.

Close a configuration menu  2. Tap anywhere outside the menu or
dialog.

Click anywhere outside the menu or
dialog.

Move a menu. Touch and hold the menu title bar or a
blank area in the menu, then drag the
menu to new position.

Click and hold the right mouse button on
title or blank area, drag to new position.

1 Not all measurement or search badges display navigation buttons.
2 Some dialog boxes will not close until you click an OK, Close, or other button in the dialog.
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Task Touchscreen UI action Mouse action
Move a note  3. Touch and hold on a note and quickly  4

start to drag, then move to new position.
Click and hold the right mouse button on
the note and quickly start to drag, then
move to the new position.

Change horizontal or vertical settings
directly on a waveform.
Vertical changes only apply to the
selected channel or waveform; horizontal
changes apply to all channels and
waveforms.

Tap a badge and use the Scale buttons.
Touch and hold two fingertips on the
waveform view, move them together or
apart vertically or horizontally, lift from
screen; repeat.

Left-click a channel, waveform, or
Horizontal badge and click on the Scale
buttons.

Increase or decrease the zoom area
(while in Zoom mode)

Touch and hold two fingertips on the
waveform view, move them together or
apart vertically or horizontally, lift from
screen; repeat.

Click the + or - buttons on the Zoom Title
bar.
Click the Draw-a-Box button, draw a box
around the waveform area of interest.

Quickly scroll or pan a waveform or list. Touch and drag in the waveform or list. Click and drag in the waveform or list.
Close or open the Results Bar to
increase the Waveform View area.

Tap on the Results Bar Handle (three
vertical dots in border) or anywhere in the
border between the Waveform View and
the Results Bar.

Click the Results Bar Handle (three
vertical dots in border) or anywhere in the
border between the Waveform View and
the Results Bar.
Click and drag the Results Bar divider.

Change the position of badges in the
Settings Bar or Results Bar.
See the Help topic Rearranging waveform
and measurement badges for more
information on moving badges.

Touch and drag the badge to a new
position in the same bar.

Click and drag the badge to a new
position in the same bar.

3 Notes are screen objects and are not associated with any particular waveform channel or slice.
4 Start to move the note as soon as selected (highlighted), otherwise the UI opens the right-click menu.
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Configure the instrument

Set the time zone and clock readout format
Set the time zone to your region so that saved files are marked with the correct date and time information. You can also set the
time format (12 or 24 hour clock).

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.
 

 

2. To turn off showing the date and time on the screen, tap the Display button to Off.

To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the
configuration menu, and set the Display button to On.

3. Select a time format (12 Hour or 24 Hour).

4. Tap the Time Zone field and select the time zone that applies to your location.

5. Tap anywhere outside of the menu to close it.

Download and install the latest 4 Series MSO firmware
Installing the latest firmware helps ensure that your oscilloscope is taking the most accurate measurements.

Prerequisite: Save any important on-instrument files (waveforms, screen captures, setups, and so on) to a USB drive or network.
The installation process does not remove user-created files, but it is a good idea to back up important files before an update.

Prerequisite: Determine the current version of firmware installed on the oscilloscope (see Help > About).

Update oscilloscope firmware from a USB drive

1. Open up a Web browser on a PC and go to www.tek.com/product-support.

2. Enter the oscilloscope model number in the search field and click Go.

3. Scroll down the screen and click the Software tab.

4. If the listed available firmware version is newer than what is on your oscilloscope, select and download that file to your PC.

5. Follow the installation instructions that came with the downloaded firmware to create the firmware install file or files.

6. Copy the firmware install file or files to a USB flash drive.

7. Follow the instructions that came with the downloaded firmware to install the firmware on the oscilloscope.

8. To confirm that the firmware was updated, tap Help > About in the Menu bar and verify that the firmware version number
listed on the screen is the same version that you downloaded.
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Run Signal Path Compensation (SPC)
Run SPC at regular intervals for best measurement accuracy. You should run SPC whenever the ambient (room) temperature
has changed by more than 5 °C (9 °F), or once a week if you use vertical scale settings of 5 mV per division or less.

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path, caused by temperature variations
and/or long-term signal path drift. Failure to run SPC on a regular basis may result in the oscilloscope not meeting warranted
performance levels at low volts per division settings.

Prerequisite: Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

1. Power on and warm up the oscilloscope for at least 20 minutes.

2. Tap Utility > Calibration.

3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take 10 minutes per channel to
run, so wait until the SPC Status message changes to Pass before reconnecting probes and using the oscilloscope.

CAUTION. You can abort the SPC calibration by tapping Abort SPC. This may leave some channels uncompensated,
resulting in possible inaccurate measurements. If you do abort the SPC, make sure to run the SPC procedure completely
before using the instrument to take measurements.

4. Close the Calibration configuration dialog when SPC has completed.

5. If the SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run the SPC
again. If the SPC still fails, contact Tektronix Customer Support.

Compensate the TPP Series probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for an unlimited number of probe/channel combinations.

The oscilloscope stores the compensation values for each probe/channel combination, and automatically recalls the
compensation values when you plug in the probe. Probe compensation status is shown in the Probe Setup panel of the Channel
configuration menu.

■ If the Probe Compensation Status field displays Pass, the probe is compensated and ready for use.

■ If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have
this probe compensation procedure run.

■ If the Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure.
Reconnect the probe and run probe compensation again.

■ If there is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for
that probe. See the oscilloscope Help for how to manually compensate passive probes not supported by the probe
compensation function.

Use this procedure to compensate supported TPP-family probes that show a Default status when connected to the oscilloscope.

NOTE. Doing a Default Setup does not delete probe compensation values. A factory calibration does delete all stored probe
compensation values.
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Prerequisite: The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

1. Connect a supported probe to an input channel.

2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals on the lower right of the oscilloscope
(see following image).

Connect the probe tip to the 1 kHz source, and the ground clip to the ground. For best results, remove any probe tip
accessories and hold the probe tip directly onto the 1 kHz connector.

NOTE. Connect only one probe at a time to the PROBE COMP terminals.

3. Turn off all channels.

4. Turn on the channel to which the probe is connected.

5. Push the front-panel Autoset button. The screen displays a square wave.

6. Double-tap the badge of the channel that you want to compensate.

7. Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe
to another channel and start again from step 1, or connect a different probe to this channel and start from step 1.

If the Probe Compensation Status says Default, continue with this procedure.

8. Tap Compensate Probe to open the Probe Compensation dialog.

9. Tap Compensate Probe to run the probe compensation.

10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and
ground from the PROBE COMP terminals.

11. Repeat these steps for each supported passive probe that you want to compensate for this channel.

12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

NOTE. For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.
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Connect to a network (LAN)
Connecting to a network allows you to remotely access the instrument.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP
address, Subnet Mask, DNS IP address, and so on).

1. Connect a CAT5 cable from the oscilloscope LAN connector to your network.

2. Select Utility > I/O on the menu bar to open the I/O configuration menu.

3. Obtain or enter the network address information:

■ If your network is DHCP-enabled, and the IP address field does not already show and address, tap Auto to obtain the
IP address information from the network. DHCP mode is the default mode.

■ If your network is not DHCP-enabled, or you need a permanent (non-changing) IP address for this instrument, tap
Manual and enter the IP address and other values provided by your IT or system administrator resource.

4. Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the
instrument successfully connects to your network. If you have problems connecting to your network, contact your system
administration resource for help.

Cleaning
Use a dry, soft cotton cloth to clean the outside of the unit. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl
alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do not use any liquid cleaning agents or
chemicals that could damage the touch screen, case, controls, markings or labels, or possibly infiltrate the case.
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Operating basics
These procedures are an introduction to using the interface to do common tasks. See the Help information in the application for
detailed information on menu and field settings.

Add a channel waveform to the display
Use this procedure to add a channel signal to the Waveform View.

1. Connect signal(s) to the channel input(s).

2. Tap an Inactive Channel button (in the Settings bar) of a connected channel.

The selected channel is added to the Waveform View and a Channel badge is added to the Settings bar.

3. Continue tapping Inactive Channel buttons to add more channels (digital or analog). Channels are displayed from lowest-
numbered channel at the top, to highest-numbered channel at the bottom of the view, regardless of the order they were
added (in stacked mode).

4. Double-tap a channel badge to open that channel's configuration menu to check or change settings.
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Configure channel or waveform settings
Use the channel and waveform configuration menus to set parameters such as vertical scale and offset, coupling, bandwidth,
probe settings, deskew values, external attenuation values, and other settings.

Prerequisite: There is a channel or waveform badge in the Settings bar.

1. Double-tap a Channel or Waveform badge to open a configuration menu for that item.

For example, in a Channel menu, use the Vertical Settings panel to set basic probe parameters such as vertical scale and
position, offset, coupling, termination, and bandwidth limit.
 

 

Available settings depend on the probe.
 

 

2. Tap the Probe Setup panel to confirm probe settings and run configuration or compensation on supported probes.
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3. Tap the Other panel to set probe deskew, external attenuation, and alternate units parameters.
 

 

4. Tap the Help icon on the menu title to open the help topic for more information.

5. Tap outside the menu to close the menu.

Quickly display a waveform (Autoset)
The Autoset function analyzes the signal characteristics and changes the instrument Horizontal, Vertical, and Trigger settings to
automatically display a triggered waveform. You can then make further changes to trigger and horizontal settings to view the
waveform point of interest.

1. Connect the probe with the signal of interest to an available channel. The signal can be analog or digital.

2. Double-tap the Trigger badge and set the trigger source to that of the signal of interest.

3. Connect any other associated signal(s) to available channel input(s).

4. Add the channel waveforms to the Waveform view. See Add a channel waveform to the display on page 35.

5. Tap File > Autoset or push the front-panel Autoset button. When using the Stacked Display mode, the instrument analyzes
the signal characteristics of the trigger source channel (analog or digital) and adjusts the horizontal, vertical, and trigger
settings accordingly to display a triggered waveform for that channel. The Vertical scale is adjusted in each waveform slice
of all active waveforms to maximize ADC utilization.

When using the Overlay Display mode, the instrument adjusts the horizontal and trigger settings of the trigger source
channel to display a triggered waveform for that channel. Vertical scale and position adjustments for all active channels in
Overlay Display mode are controlled by the Autoset in Overlay Display Mode Optimizes selection in the Autoset panel of
the User Preferences menu. If the selection is Visibility, Autoset vertically scales and positions all active channel
waveforms such that they are uniformly spaced on screen. If the selection is Resolution, Autoset vertically scales and
positions all active channel waveforms such that they each use as much of the ADC's range as possible.

NOTE. You can set which parameters the instrument can adjust when running an Autoset. See the Autoset panel in Utility >
User Preferences > Autoset.

Autoset guidelines:

■ Autoset displays three or four cycles (depending on the detected signal) with the trigger level near the midlevel of the signal.

■ The trigger is set to type Edge, rising slope, DC coupling.

■ If no channels are displayed before pushing Autoset, the oscilloscope adds Ch 1 to the Waveform view whether it has a
signal or not.

■ Autoset ignores math, reference, and bus waveforms.

■ A channel or waveform with a frequency less than 40 Hz is classified as no signal.
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How to trigger on a signal
Use this procedure to open the Trigger menu to select and configure the trigger event type and conditions.

1. Double-tap the Trigger badge on the Settings bar to open the Trigger configuration menu.

2. Select a trigger from the Trigger Type list. The trigger type sets what fields are available in the menu and also updates the
illustration to show a graphic of the trigger type.
 

 

NOTE. To trigger on a bus, you must first add the bus to the Waveform view. See Add a math, reference, or bus waveform
on page 40

NOTE. Triggering on buses other than Parallel requires purchasing and installing serial trigger and analysis options. See the
Tektronix Web site for available serial trigger and analysis options.

3. Select the other fields and panels to refine the trigger conditions. The menu fields and trigger graphic update as you make
changes to the trigger settings. Displayed fields depend on the selected trigger type. Selection changes take effect
immediately.
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4. Tap the Help icon on the menu title for more information on these settings.

5. Tap outside the menu to close the menu.

Set the acquisition mode
Use this procedure to set the method the instrument uses to acquire and display the signal.

1. Double-tap the Acquisition badge on the Settings bar to open the Acquisition configuration menu.

2. Select the acquisition method from the Acquisition Mode list. Set any other parameters associated with the selected
acquisition type.
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3. Tap the Help icon on the menu title for more information on these settings.

4. Tap outside the menu to close the menu.

Set Horizontal parameters
Use this procedure to set the horizontal time base parameters such as mode, minimum sample rate, horizontal scale, delay, and
trigger delay time (relative to the center of the waveform record.

1. Double-tap the Horizontal badge on the Settings bar to open the Horizontal configuration menu.
 

 

2. Use the menu selections to set horizontal parameters.

3. Tap the Help icon on the menu title for more information on these settings.

Add a math, reference, or bus waveform
Math waveforms let you create new waveforms based on operations between two or more waveforms or by applying equations to
waveform data. A reference waveform is a static waveform record displayed for comparison. Bus waveforms let you view and
analyze serial or parallel data.

There is no set limit to the number of Math, Reference, or Bus waveforms you can add to the Waveform View, other than system
physical memory constraints.

1. Tap the Add New Math, Add New Ref, or Add New Bus button in the Settings bar.
 

 

2. The instrument adds the waveform to the Waveform view, adds a Waveform badge to the Settings bar, and opens a
configuration menu. This example shows adding a Math waveform.
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3. Use the configuration menus to refine the waveform parameters. Displayed fields depend on the waveform and selections
made in the menu. Selection changes take effect immediately.
This example shows adding a Math waveform, using the Math Source fields to select Ch 1 and Ch 2 as the waveform
sources, set the math type to Basic math operation, and subtracting channel 2 from channel 1.
 

 

4. When adding a Reference waveform, the instrument displays a Recall configuration menu. Navigate to and select the
reference waveform file (*.wfm) to recall, then tap the Recall button. The instrument displays the Reference waveform.

5. Double-tap a math, reference, or bus badge to check or change that waveform's settings.

6. Tap the Help icon on a configuration menu title for more information on math, reference, and bus waveform settings.

7. Tap outside the menu to close the menu.
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Add a measurement
Use this procedure to select and add measurements.

1. Acquire the channel(s) and/or waveform(s) on which you want to take measurements.
 

 

NOTE. Waveforms do not need to be displayed to be used for measurements, as long as the channel or waveform badge is
on the Settings bar and is acquiring the signal to measure.

2. Tap the Add New...Measure button to open the Add Measurements configuration menu.
 

 

NOTE. If the menu shows tabs other than Standard, then optional measurement types have been installed on the
instrument. Select a tab to show the measurements for that option.

3. Tap the Source field and select the measurement source. The list shows all available sources that are valid for the
measurement.

4. Select a measurement category panel, such as Amplitude Measurements or Timing Measurements, to display
measurements for those categories.

5. Select a measurement and tap Add to add the measurement to the Results bar. You can also double-tap a measurement
to add it to the Results bar.
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6. Select and add other measurements for the current source. Tap the measurement category panels to display and select
other measurements to add.

7. To add measurements for other sources, select a different source, select a measurement, and add the measurement.
 

 

8. Tap outside the Add Measurements menu to close the menu.

9. To further adjust a measurement's settings, double-tap a measurement badge to open a configuration menu for that
measurement. See Configure a measurement on page 44.

10. Tap the Help icon on the menu title for more information on settings.
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Configure a measurement
Use this procedure to add statistical readouts to the measurement badge, display plots for the measurement, and refine
measurement parameters (configuration, global versus local scope of settings, gating, filtering, and so on).

1. Double-tap a measurement badge to open its Measurement configuration menu.
 

 

2. Tap Show Statistics in Badge to add statistical readouts to the measurement badge.
 

 

3. Tap available panel titles to make changes for those categories.
 

 

4. Use the available fields to refine the measurement conditions. Displayed fields depend on the measurement. Selection
changes take effect immediately. Selection changes can also change fields in other panels.

5. Tap the Help button on the menu title for more information on this menu's settings.

6. Tap outside the menu to close the menu.
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Add a plot of a measurement
Measurement plots let you graph the distribution of waveform data point occurrences (histogram), plot the frequency components
(spectrum) of a waveform, show the time trend of a measurement, and other supported plots. Available plots depend on the
measurement.

1. Double-tap a Measurement badge to open the Meas configuration menu.
 

 

2. Tap a Plots button to add that plot for the measurement to the screen.
 

 
The following shows adding a Histogram plot.
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You can add more than one plot to measurements (to different measurements or the same measurement). For example,
you can add two histogram plots for the same measurement, set one to display the X-Axis with a Logarithmic scale, and the
other plot to display the X-Axis with a Linear scale.

3. You can move plot windows by dragging the Plot view title bar to a new position. The blue background area moves to show
where the plot will be located when you remove your finger from the title bar. You can also resize plot windows by selecting
and dragging the Plot view border. You should use a mouse to do these operations, as it is easier to select and drag plots
with a mouse.
 

 

4. Double-tap within a Plot view to open a configuration menu to set display characteristics. Tap the Help icon on the
configuration menu title for more information on that menu's settings. Tap outside the menu to close the menu.
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Add a Search
Use this procedure to set search criteria and mark a waveform where those events occur.

You can search on analog and digital signals, math waveforms, and reference waveforms. You can add searches to different
waveforms and multiple searches to the same waveform. Prerequisite: Display the channel or waveform signal on which to
search. The waveform must be displayed to create a search for it.

1. Display the channel or waveform signal on which to search. The waveform must be displayed to create a search for it.

2. Tap the Add New...Search button to open the Search configuration menu.
 

 

3. Use the configuration menu fields to set the search criteria in the same way that you would set for a trigger condition (select
the Search Type, Source, and conditions on which to search).

NOTE. You cannot search for sequential events (there is no Sequence search type).

4. The searched waveform is marked with one or more triangles as soon as the search criteria becomes true. Each search
uses a different color for its markers. The example image shows search criteria set to find positive pulse widths that are less
than 70 ns wide.
 

 

5. To stop showing marks on a waveform, double-tap the Search badge and tap Display to Off.

6. To move the waveform to center marks on the display, push the Run/Stop front panel button to stop acquisition, single-tap
a Search badge, and tap the < or > Navigation button.
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NOTE. Navigation buttons are only functional when the oscilloscope acquisition mode is set to Stop.

This opens the Zoom mode and moves the waveform to the previous or next event mark on the waveform.

7. If available for a search, tap the Min or Max button to center the waveform in the display at the minimum or maximum value
of the search events in the waveform record.

8. To return the instrument to normal acquisition mode, tap the Zoom icon in the upper right corner of the Waveform View to
turn off Zoom mode, and push the Run/Stop front-panel button to set it to Run mode.

Delete a Measurement or Search badge
Use this procedure to remove a Measurement or Search badge from the Results bar.

1. Touch and hold the Measurement or Search badge that you want to delete. The instrument opens a right-click menu.

2. Select Delete Meas to delete that badge from the Results bar.
 

 

3. You can also delete a Measurement or Search badge by dragging it to the Trash Can icon, located at the bottom of the
Results bar. When the Trash can icon and the badge turns red, lift your finger to delete the badge. You can use the mouse
to drag and delete a badge.

NOTE. You can undo a measurement delete.
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Change waveform view settings
Use this procedure to change the waveform display mode (Stacked or Overlay), waveform trace interpolation algorithm,
waveform persistence, style and intensity, and graticule style and intensity.

1. Double-tap on an open graticule area to open the Waveform View configuration menu.
 

 

2. Tap the buttons in the Display Mode to toggle between Overlay and Stacked modes.
 

 

3. Use the other controls to set the waveform interpolation algorithm, waveform point persistence, style, and intensity, and
graticule style and intensity.

4. Tap the Help icon on the menu title to open the Waveform View menu help topic for more information on the waveform view
parameters.

5. Tap outside the menu to close the menu.

Display and configure cursors
Cursors are on-screen lines that you can move to take measurements on specific parts of a waveform or plot, or between two
different waveforms. Cursor readouts show both current position values and the difference (delta) between cursors.

1. Tap the waveform slice (in Stacked mode), or the channel or waveform badge (in Overlay mode) to which you want to add
cursors.

2. Tap the Add New...Cursors button, or push the front-panel Cursors button.

The cursors are added to the display.
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3. Use Multipurpose Knobs A and B to move the cursors, or touch and drag a cursor. Cursors show readouts that show
position and difference measurements between the cursors.

4. To move the cursors to a different channel or waveform, just tap in that waveform graticule.
 

 

5. To further configure cursors, double-tap on either cursor line or the cursor readouts to open the Cursors configuration
menu. For example, tap the Cursor type to select the cursors to display, such as Waveform, V Bars, H Bars, and V&H Bars.
 

 

6. To split the cursors between two waveforms, tap the Source field and select Split and select the source for each cursor.
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The cursors are moved to the specified waveforms.

7. Tap the Help icon on the menu title for more information on the menu settings.

8. To stop showing cursors, push the front panel Cursor button, press and hold to open the right-click menu and turn cursors
off, or open the Cursors configuration menu and set Display to Off.

Connect the oscilloscope to a PC using a USB cable
Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

1. On the oscilloscope, select Utility > I/O from the menu bar.

2. Tap USB Device Port Settings.

3. Confirm that the USB Device Port control is On (default setting).

4. Connect a USB cable from the PC to the USB Device port on the rear of the instrument.

5. If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address
for your configuration (0 - 30).

See Help for information on other operations
Open the Help viewer (Help > Help) to select and view information on other instrument operations.
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EMC, safety and environmental compliance

Compliance Information
This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies. This product is intended for use by professionals and trained personnel only; it is not designed for use in households or
by children.

Questions about the following compliance information may be directed to the following address:

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC compliance

EU EMC Directive
Meets intent of Directive 2014/30/EU for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1, EN 61326-2-1. EMC requirements for electrical equipment for measurement, control, and laboratory use.  1 2 3 4

■ CISPR 11. Radiated and conducted emissions, Group 1, Class A

■ IEC 61000-4-2. Electrostatic discharge immunity

■ IEC 61000-4-3. RF electromagnetic field immunity

■ IEC 61000-4-4. Electrical fast transient / burst immunity

■ IEC 61000-4-5. Power line surge immunity

■ IEC 61000-4-6. Conducted RF immunity

■ IEC 61000-4-11. Voltage dips and interruptions immunity

EN 61000-3-2. AC power line harmonic emissions

EN 61000-3-3. Voltage changes, fluctuations, and flicker

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 Equipment may not meet the immunity requirements of applicable listed standards when test leads and/or test probes are connected due to coupling of electromagnetic

interference onto those leads/probes. To minimize the influence of electromagnetic interference, minimize the loop area between the unshielded portions of signal and
associated return leads, and keep leads as far away as possible from electromagnetic disturbance sources. Twisting unshielded test leads together is an effective way to
reduce loop area. For probes, keep the ground return lead as short as possible and close to the probe body. Some probes have accessory probe tip adapters to
accomplish this most effectively. In all cases, observe all safety instructions for the probes or leads used.

4 For compliance with the EMC standards listed here, high quality shielded interface cables that incorporate low impedance connection between the cable shield and the
connector shell should be used.
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EMC Compliance
Meets the intent of Directive 2014/30/EU for Electromagnetic Compatibility when it is used with the product(s) stated in the
specifications table. Refer to the EMC specification published for the stated products. May not meet the intent of the directive if
used with other products.

Australia / New Zealand Declaration of Conformity – EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

■ EN 61326-1 and EN 61326-2-1. Radiated and conducted emissions, Group 1, Class A.

Safety compliance
This section lists the safety standards with which the product complies and other safety compliance information.

EU low voltage directive
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:

Low Voltage Directive 2014/35/EU.

■ EN 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General
Requirements.

■ EN 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

U.S. nationally recognized testing laboratory listing
■ UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General

Requirements.

■ UL 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

Canadian certification
■ CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use

– Part 1: General Requirements.

■ CAN/CSA-C22.2 No. 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory
Use – Part 2-030: Particular requirements for testing and measuring circuits.

Additional compliances
■ IEC 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1:

General Requirements.

■ IEC 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

Equipment type
Test and measuring equipment.
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Safety class
Class I -- grounded product.

Pollution degree description
A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment for
which they are rated.

■ Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

■ Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is caused
by condensation must be expected. This location is a typical office/home environment. Temporary condensation occurs only
when the product is out of service.

■ Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

■ Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical outdoor
locations.

Pollution degree rating
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor, dry location use only.

IP rating
IP20 (as defined in IEC 60529).

Measurement and overvoltage category descriptions
Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following categories
(see specific ratings marked on the product and in the manual).

■ Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.

■ Measurement Category III. For measurements performed in the building installation.

■ Measurement Category IV. For measurements performed at the source of low-voltage installation.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating
Overvoltage Category II (as defined in IEC 61010-1)

Environmental compliance
This section provides information about the environmental impact of the product.
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Restriction of hazardous substances
Complies with RoHS2 Directive 2011/65/EU.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life.
To avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to
Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Battery recycling
This product contains a small installed lithium metal button cell. Please properly dispose of or recycle the cell at its end of life
according to local government regulations.

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state of California, CR
lithium batteries are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Transporting batteries
The small lithium primary button cell contained in this equipment does not exceed 1 gram of lithium metal content per cell, and
the cell type has been shown by the manufacturer to comply with the applicable requirements of the UN Manual of Tests and
Criteria Part III, Sub-section 38.3. Consult your carrier to determine which lithium battery transportation requirements are
applicable to your configuration, including to its re-packaging and re-labeling, prior to reshipment of the product by any mode of
transport
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Index
A
A knob, 7
Acquisition controls, 7
acquisition menu, open, 39
add

a channel to the display, 35
a measurement badge, 42
a measurement plot, 45
a search badge, 47
measurement statistical readouts to badge, 21
signal to the screen, 35
waveform to the screen, 35

Add New
Bus waveform button, 16
Math waveform button, 16
Ref waveform button, 16

AFG option, 16
AFG Out (rear panel), 14
automatic probe compensation (TPP series), 32
Autoset, 37
Autoset button, 7
AUX Out (rear panel), 14
avoid pinching when rotate handle, 1

B
B knob, 7
badge types, 20, 22–25
badges, 20, 22–25
Bus button, 7
bus waveforms, 40

C
cable lock, 14
change display settings, 49
change measurement settings, 44
channel badge, 20, 22–25
Channel buttons (front panel), 7
channel menu, 36
channel settings, 36
channel vertical parameters menu, 36

Clear button, 7
clipping message, 20, 22–25
clock format (12/24 hr), how to set, 31
common touchscreen UI tasks, 28
compensate TPP series probes, 32
configuration menus, 26
configure a measurement, 44
connect lock cable, 3
connect to a network, 34
connecting probes, 5
correct handle rotate, 1
Cursors button, 7
Cursors button (touchscreen), 15
cursors menu, 49

D
Default Setup button, 7
delete a measurement badge, 48
display a channel, 35
display cursors, 49
Draw-a-Box button, 15
Draw-a-Box button (Zoom), 27
DVM option, 16
dynamic range limit marker, 16

E
Environment requirements, 2
Errors, 23
Ethernet port (rear panel), 14
Ethernet, connect to, 34
expansion point, waveform, 16

F
Fast Acq button, 7
firmware, how to update, 31
FlexChannel connectors (front panel), 7
Force button, 7
front panel

Acquisition, 7
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Autoset button, 7
Aux In, 7
Aux Trig, 7
Bus button (front panel), 7
Channel buttons (front panel), 7
Clear button, 7
Cursors button, 7
Default Setup, 7
description, 7
Fast Acq button, 7
FlexChannel connectors, 7
Force button, 7
High Res button, 7
Horizontal, 7
Level knob, 7
Math button (front panel), 7
Miscellaneous, 7
Mode button, 7
multipurpose knobs, 7
Navigate buttons (front panel), 7
Position knob, 7
Position knob (horizontal), 7
probe compensation connectors, 7
Ref button (front panel), 7
Run/Stop button, 7
Scale knob, 7
Scale knob (horizontal), 7
Single/Seq button, 7
Slope button, 7
Touch Off button, 7
Trigger, 7
USB ports, 7
Vertical, 7
Zoom button (front panel), 7
Zoom/Pan knobs (horizontal), 7

G
GPIB talk/listen address, 51
graticule intensity, 49
graticule style, 49

H
handle rotate, 1

handles, analog and digital, 16
High Res button, 7
Horizontal controls, 7
horizontal menu, open, 40
how to

add a measurement, 42
add a measurement plot, 45
Add bus waveform, 40
Add math waveform, 40
Add reference waveform, 40
add waveform to screen, 35
change display settings, 49
change graticule intensity, 49
change graticule style, 49
change measurement settings, 44
change persistence, 49
change waveform intensity, 49
change waveform interpolation, 49
check power-on self tests results, 5
compensate TPP series probes, 32
connect probes, 5
connect to network, 34
connect to PC using USB cable, 51
delete a measurement, 48
display cursors, 49
download, install firmware, 31
open acquisition menu, 39
open horizontal menu, 40
quickly display waveform (Autoset), 37
run signal path compensation (SPC), 32
search on an event, 47
set acquisition parameters, 39
set channel vertical parameters, 36
set clock format (12/24 hr), 31
set GPIB talk/listen address, 51
set horizontal parameters, 40
set probe deskew, 36
set probe parameters, 36
set time zone, 31
set trigger parameters, 38
update firmware, 31
use Autoset, 37
use mouse with the UI, 28
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How to
change display mode (stacked, Overlay), 49

I
inactive channel buttons, 16
input signal level requirements, 3
intensity, graticule, 49
intensity, waveform, 49

K
knob A, 7
knob B, 7

L
LAN port (rear panel), 14
LAN, connect to, 34
Level knob, 7
lock to bench or rack, 3

M
marking waveform events (search), 47
Math button, 7
math waveforms, 40
Measure button, 15
measurement

plots, 45
measurement badge, 20, 22–25
measurement badge, delete, 48
Menu bar, 15
menu panels, 26
menus, 26
Miscellaneous controls, 7
Mode button (front panel), 7
mouse touchscreen UI equivalents, 28
move cursors, 49
multipurpose knobs, 7

N
Navigate buttons (horizontal), 7
navigation buttons, badges, 20, 22–25
network, connect to, 34

Note button, 15

O
open acquisition menu, 39
open horizontal menu, 40
operating

altitude range, 2
humidity range, 2
temperature range, 2

operating power requirements, 2
overlay mode (waveforms), 49

P
Pan, 27
panels, menu, 26
persistence, waveform, 49
pinching and handle rotate, 1
plot a measurement, 45
Plot button, 15
Position knob, 7
Position knob (horizontal), 7
power cord connector (rear panel), 14
power requirements, 2
power standby mode, 4
power-on test results, 5
powering on or off, 4
probe compensation (TPP series), 32
probe compensation connectors, 7
probe deskew, set, 36
Probe errors, 23
probe inputs, 7
probe parameters, set, 36
probes, connecting, 5
proper handle rotate, 1

R
rack mount kit information, 6
rear panel

AFG Out, 14
AUX Out, 14
cable lock, 14
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Ethernet port (RJ-45), 14
LAN port (RJ-45), 14
power cord, 14
security cable lock, 14
USB Device port, 14
USB Host ports, 14
video output, 14

rear panel connections, 14
record view, waveform, 16
Ref button, 7
Ref In, 14
Ref In (rear panel), 14
reference waveforms, 40
remove AC power from instrument, 4
requirements

altitude, 2
environment, 2
humidity, 2
power, 2
signal inputs, 3
temperature, 2

Results bar, 15
Results Table button, 15
RM4 rack mount, 6
run signal path compensation, 32
Run/Stop button, 7

S
Save button, 7
scale buttons, badge, 20, 22–25
Scale knob, 7
Scale knob (horizontal), 7
search badge, 20, 22–25
Search button, 15
searching for events, 47
security cable lock, 14
set

clock format (12/24 hr), 31
GPIB talk/listen address, 51
probe deskew, 36
probe parameters, 36
time zone, 31

Settings bar, 15
show a measurement, 42

signal input levels, 3
Single/Seq button, 7
Slope button (front panel), 7
SPC (signal path compensation), 32
stacked mode (waveforms), 49
standard accessories, 1

T
TekVPI input connectors, 7
time zone, how to set, 31
Touch Off button, 7
touchscreen UI tasks, 28
Trash Can icon, 15
trigger

level indicators, 16
position indicator, 16

Trigger controls, 7
trigger menu, 38
trigger the oscilloscope, 38
turn instrument on or off, 4

U
USB cable, connect to PC, 51
USB Device port (rear panel), 14
USB Host ports (rear panel), 14
USB ports (front panel), 7
use cursors, 49
using mouse with the touchscreen, 28

V
Vertical controls, 7
video output (rear panel), 14

W
waveform

expansion point, 16
intensity, 49
persistence, 49
record view, 16

waveform badge, 20, 22–25
Waveform View, 15

Index  

60 MSO44, MSO46 Installation and Safety Manual

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Z
Zoom box, 27
Zoom button (front panel), 7

zoom icon, 16
Zoom overview, 27
Zoom title bar, 27
Zoom/Pan knobs (horizontal), 7
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